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Reports 

Running On-Demand Reports 

Reports can be run manually for most features available in the application. There is no single collection of 
reports other than those for dashboards and emails. 

 

The best practice is to check along the top of the screen for an Options or View button. If these are present, it 

generally means there is a report that can be exported. 

 

Options 

Used to select the date range, vehicles/drivers, display historical vehicles, sub-periods. 

Sort by 

Used to sort the report by name, duration, count, group, etc. 

View 

Typically, List (interactive view in the database), Report (summary), and Advanced (detailed). Changing the view 

changes the level of detail and allows for the report to be downloaded as either a PDF or Excel document. 

 

Top 
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Setting up Dashboard Reports 

Assigns a report to be part of the Dashboard. 

1. Click on Administration on the home screen.  

2.  Click on Reports... and then Report Views. 

3. Click on a report by either scrolling through the reports list or by using the “Template name” field to 

search for one. 

4. Click on the Dashboard tab, then click on the Yes button to the right of “Dashboard graphic options”. 

5. Select who can view the report in their dashboard by clicking on the dropdown arrow to the right of 

“Dashboard viewers” or by clicking in the “Select groups…” field to the right of “Dashboard viewers” 

and entering a group’s name. 

6. Click the Yes button to the right of “Include me as a dashboard viewer” to view the report on your 

dashboard. 

7. Select the desired date range for the report in the list to the right of “Date range”. 

8. Click on the dropdown to the right of “Refresh period” to select how often the data will refresh itself on 

the dashboard. 

9. Click in the field to the right of “Next run” and use the calendar that populates to select when the 

report will begin. 

10. Set the desired group(s) that should be included in the data set for the report by clicking on the 

dropdown arrow to the right of “Belonging to”.  

Note: The default is “Everything” which will provide data for all configured groups. 

11. Configure the desired settings under “ADDITIONAL REPORT OPTIONS”.  

Note: The settings will differ depending on the report you selected. 

12. Click the Save button at the top of the page when complete. 

 

Top  
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Setting up Emailed Reports 

Configure reports to be sent via email. 

1. Click on Administration on the database. 

2. Click on Reports... and then Report Views. 

3. Select a report by either scrolling through the reports list or by using the “Template name” field to 

search for one. 

4. Click on the Email report tab. 

5. Click on the Yes button to the right of “Email options”. 

6. Select the desired recipients by clicking on the dropdown arrow to the right of “Recipients list” or by 

clicking in the “Select groups…” field to the right of “Recipients list” and entering user information. 

7. Click the Yes button to the right of “Email the report to me” to receive a copy of the report. 

8. The “Redirect report” feature sends the report to a single user other than yourself based on certain 

conditions. If you are a recipient, or you have selected other recipients, leave this turned off. 

9. Select the desired report format by clicking on either the PDF or Excel buttons to the right of “Type of 

report”. 

10. Select the desired time frame for the report by clicking on the desired range in the list to the right of 

“Date range”. 

11. Click in the field to the right of “Next run” and use the calendar that populates to select when the 

report will begin. 

12. Set the desired group(s) that should be included in the data set for the report by clicking on the 
dropdown arrow to the right of “Belonging to”.  

13. Configure the desired under “ADDITIONAL REPORT OPTIONS”. 

Note: the settings differ depending on the report you selected. 

14. Click the Save button at the top of the page when complete. 

 

Top  
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Adding Custom Reports 

Display reports and who has access. 

1. Click on Administration in the menu on the database. 

2. Click on Reports... and then Report views. 

3. Click the Add Excel File button at the top of the page. 

4. Drag and drop your excel file, or click on “Drop your files here or click to select them” to browse your 

computer for the file. 

5. To rename the report, click on the current report name to the right of “Report” and enter your desired 

name in the text box that populates. 

6. Click the dropdown arrow or click in the “Select groups…” field to the right of “Who can see this report” 

to choose who can see the report.  

Note: The default setting is “Everyone”. 

7. Click the Yes button to the right of “Show report in dropdown list” to show the report in Report Views, 

or to run an on-demand report. 

8. The “ADDITIONAL REPORT OPTIONS” displays, configure the additional settings as desired. 

Note: The settings displayed depend on the report that your file is based on.  

9. Click on the Dashboard or Email report tabs if you wish to configure the settings in each. 

10. Click the Save button at the top of the page when complete. 

 

Top 
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Adding Default Reports 

The AT&T Fleet Management for Enterprise/Government database offers a number of built-in reports, which 

can be run on-demand or automated. These reports can be divided into different categories: 

  

 
 
Top  
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Maps 

Keeping track of vehicles on the map is important for any fleet. Knowing where vehicles are at any time is 
imperative to productivity in a day, and allows for a view of the overall fleet. 

 

Viewing Locations on the Map 

Using the map. 

1. Click on Map in the menu on the left side of the database. 

2. To zoom into an area, click on the + sign, or use the scroll wheel on your mouse.  

3. To zoom out, click on the – sign, or scroll the mouse wheel in the opposite direction. 

4. To navigate to a specific location, click on the “Vehicle, VIN, Zone, Route, or address” field and enter 

the desired address. 

 
Tracking Vehicles 

View vehicles current position and status on a map. 

1. Click on Map in the menu on the left side of the database.  

2. Vehicle locations are automatically displayed on the map for fleets under 50 vehicles. 

3. If there are more than 50 vehicles, select the dropdown arrow to the right of the “Vehicle, VIN, zone, 

route or address” field and select the desired vehicle(s). 
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4. The vehicle list displays and vehicle positions are visible on the map. 

5. The vehicle list is sorted by its status: 

• Vehicles currently driving are listed first, followed by vehicles that are stopped. 

• Vehicles stopped inside of a zone show the location underlined in the zone’s color. 

 

 
 

 

 
 

  

6. The vehicle’s shape on the map changes depending on its status: 

• Driving = triangle 

• Stopped = square 

• Stopped in zone = star 

7. To focus the map on a specific vehicle, click on its name in the vehicle list. 

8. Hover your mouse over a vehicle to see the current speed (if driving), or the time of arrival (if stopped). 

 Top  
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Map Views 

Change the default map view. 

1. Use the map controls to zoom into the desired area. 

2. Click the Map dropdown at the top of the page.  

3. Click on Views and then Save this view. 

4. A confirmation message populates. Click in the field to enter a name for the new view and then click 

the Add button. 

5. Click on your user name in the top right corner of the page, then select Options. 

6. Click on the Map Settings tab. 

7. Navigate to the “View Organizer” section. 

8. Click and drag the view that you created to the top of the view list. 

9. Click the Save button at the top of the page when complete. 

 

Top 
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Additional Map Options 

Additional map options. 

1. While viewing the map, click on the Map dropdown near the top of the page. 

• “Clear map” clears any vehicles currently displayed on the map. 

• “Highlight groups” highlights specific groups on the map.  

Note: Selections can be reversed by selecting None. 

• “Map type” changes your map provider.  

Note: The new map provider can be set to default by selecting your username on the top right of 

the screen, and then clicking on Options then Map Settings. 

• “Show traffic” adds color to the roads on the map indicating traffic status. 

• “Show legend” adds or removes map symbols and exceptions from the bottom of the map. 

• “Show routes” adds new routes directly from the map or shows existing routes on the map. 

• “Show zones” adds and removes zones from the map, and can display default zones or all zones. 

 

 
 
Top  
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Trips History 

Displays details on the path a vehicle has taken during a trip. 

1. While viewing the map, click the Trips History button on the top of the page.

Note: If no vehicles are displayed on the map by default the vehicle list displays and you can select the

desired vehicle(s).

2. The Trips History report displays status by vehicle, by date. Use the forward and back arrows to the left 
of the date to view adjacent days.

Note: If no trips display, click on the Options dropdown and choose a different time frame under 

“DATE PERIOD”, and then click on the Apply changes button.

3. Click on the desired trip under the vehicle name in the trips list to display it on the map.

4. The trip is highlighted by a blue line on the map.

5. Hover over the line on the map to see the trip date, vehicle name, the assigned driver (if there is one),

assigned groups, and total distance traveled for the day.

Available Data 

Vehicle, trip start and end times, distance, max speed, driving, idling and stop durations, location and 

zone data 

Top 

Trips Summary 

A summary of vehicles and their activities for the selected date range. 

1. From “Trips History” menu, click the Summary button at the top of the page to view a summarized

version of the report.

2. The Activity and Trips Summary Report provides totals for mileage, driving time, and idling for the date

range selected.

3. Hover your mouse over the pie chart on the right for detailed information on time spent in customer,

non-customer, home, and office locations.

Note: The pie chart may not be available depending on the trips displayed.

Available Data 

Distance, max speed, idling, duration of home, customer, non-customer, and office stops, stop counts, 

duration percentages 

Top 
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Vehicles 

Vehicle management allows users to keep track of all devices, manage vehicle-based driver feedback, 
groups, and options, swap and remove devices, and change device settings and time zones. 

 

Adding Individual Vehicles 

Adds new vehicles, one at a time.  

1. Click on Vehicles the main menu on the left side of the database. 

2. Click the Add dropdown, then click Add vehicle. 

3. Click in the field to the right of “Serial number” and enter the serial number for the GO device. 

Note: The serial number is 12 characters long and contains both letters and numbers. The letter “O” is 

never a part of the serial number. Dashes are not required. 

4. Click in the field to the right of “Description” and enter a description for the vehicle (name). 

5. Click the OK button at the top of the page. 

 

Available Data 

Description/Name, device type, serial number, comment, license plate, VIN, odometer, engine hours 

Top 

 

Adding Multiple Vehicles 

Adds multiple vehicles at once using Quick Import. 

1. From the Vehicles list, click the Add dropdown and click on Quick import. 

2. Copy your list of vehicle serial numbers and descriptions and paste them in the “Serial number, vehicle 

description” field. 

3. Click the Import button. 

 
Top  
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Device Info 

Displays basic device, vehicle and engine statistics.  

1. Access the vehicles list and click on a vehicle to view its information. 

Note: The device type and serial number cannot be changed. 

2. The Vehicle ID number (VIN), Odometer, and Current engine hours fields populate automatically but 

can be edited. 

3. Users can enter or change the Description, License plate, Comments, or State/province. 

4. Click on the Save button at the top of the page when complete. 
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 Driver Feedback 

Audible in-vehicle alerts can improve the on-road driving behavior of your drivers by notifying them of 
unsafe or potentially risky driving events. 

 

1. From the “Vehicles” list, click on the vehicle you wish to edit. 

2. Click on the Driver feedback tab. 

3. Click the On button to the left of “Device beeps” to enable feedback options. 

4. Make adjustments to the options that display as desired. 

5. Click on the Save button at the top of the page when complete. 

 

 
 Top 



 

© 2019 AT&T Intellectual Property. All rights reserved. AT&T and the Globe logo Page 17 
are registered trademarks of AT&T Intellectual Property. 
   

Feedback Options 
• Driver identification reminder is used with IOX-NFC Driver ID. The slider determines how many 

seconds before beeping to remind the driver to swipe an NFC fob. Once swiped, beeping stops. 

• Beep on engine RPM prompts the device to beep if RPM exceeds the set value. Pro or ProPlus 

subscriptions are required for this feature. If you are interested in upgrading to the ProPlus plan, please 

contact your AT&T account manager. 

• Beep when idling for a period of time prompts the device to beep if the vehicle idles longer than the 

specified time. 

• Speed warning requires two speeds: Start Beeping is the speed at which the device begins beeping, 

and Stop Beeping is the speed at which the device stops beeping. It is recommended to start beeping 

at the highest speed and stop at a lower speed. Beep briefly when approaching warning speed is used if 

the vehicle approaches stop beeping speed. 

• Beep on dangerous driving beeps when dangerous driving is detected. Select the box or drag the slider 

to set the vehicle type. Passenger Car = least sensitive, Heavy-Duty = most sensitive, and Truck/Cube 

Van = middle. Pro or ProPlus subscriptions are required for this feature. If you are interested in 

upgrading to the ProPlus plan, please contact your AT&T account manager. 

• Beep when seat belt not used sets the speed at which device beeps with seat belt unbuckled. Select to 

Monitor both passenger and driver seat belts. Pro or ProPlus subscriptions are required for this 

feature. If you are interested in upgrading to the ProPlus plan, please contact your AT&T account 

manager. 

• Beep when reversing uses accelerometer data to determine when the vehicle is in reverse. Pro or 

ProPlus subscriptions are required for this feature. If you are interested in upgrading to the ProPlus 

plan, please contact your AT&T account manager. 

 

Top 

 

Groups 

Assign vehicles to a group. 

1. From the “Vehicles” list, click on the vehicle you wish to assign.  

2. Click on the Groups tab. 

3. Click on the dropdown arrow to the right of “Groups” or click in the “Select groups…” field right of 

“Groups” and enter the desired groups information to select a group.  

Note: Messaging status groups are not required. 

4. Click on the Save button at the top of the page when complete. 

 
Top  
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More Details 

Displays detailed device, vehicle, and user statistics. This includes device, compliance, and vehicle compliance 

management options. 

1. From the “Vehicles” list, click on the desired vehicle. 

2. Click on the + More details button at the top of the page to display additional fields and options on the 

Device tab.  

Note: This button also creates tabs for Auxiliaries and Custom parameters. 

3. Make any changes to odometer data or options under “DETAILED DEVICE INFO”. 

4. Click the Save button at the top of the page when complete, or continue to the Auxiliaries tab to set up 

driver feedback for Auxiliary devices in the vehicle. 

5. Click on the Custom parameters tab to enter any custom parameters for the vehicle. 

6. Click on the Save button at the top of the page when complete. 

 

Unplugging Devices 
Makes the device inactive while keeping vehicle data. 

1. Click on Vehicles in the menu on the left side of the database. 

2. Click on the desired vehicle. 

3. Click the + More details button at the top of the page, then click on the Unplug Device button. 

4. A confirmation message populates, click on the Unplug Device button to confirm. 

5. Click on the Save button at the top of the page when complete. 

 

Replacing Device 
Replaces a vehicle’s GO device while keeping trips data associated with the vehicle. 

1. Click on Vehicles in the menu on the left side of the database. 

2. Click on the desired vehicle. 

3. Click the on the + More details button, then click on the Replace with new device button. 

4. Click in the field to the right of “Serial number” and enter the new device’s serial number.  

5. Click on the OK button at the top of the page. 

6. Click on the Save button at the top of the page when complete. 

 
Top  
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Active Tracking 
Refreshes vehicle location every second for up to 20 moving vehicles on the Map. 

• Allows continuously up-to-date vehicle positions on the live map. 

• If the GO device is on the Pro plan, toggling Active Tracking to On will activate the ProPlus plan. For 

more information or to add the Pro plan to your account, please reach out to your AT&T account 

manager. 

  

Detailed Device Info 
• Work time is used in conjunction with rules. Select work hours from the dropdown list. 

• Time zone is used to select the time zone in which the asset will spend most of its time. This feature is 

important for reporting. 

• GO TALK language is used in conjunction with devices connected to a GO TALK IOX. Select the 

appropriate language from the dropdown list. 

• Turn GPS receiver off can force a GPS receiver to remain on after ignition OFF. Useful for fleets that 

require constant GPS accuracy. 

• Periodically wake GPS is used to improve GPS lock on startup. 

• Hours of service (HOS) controls the creation of duty status logs for HOS compliance. On enables the 

device to create automatic duty status logs when the vehicle exceeds 5 MPH. If set to Off, the device 

will NOT create automatic duty status logs. Automatic will auto-activate if the system determines that 

the vehicle is using HOS features.  

• Turn external device off is used if an external device is connected via IOX, this setting controls when it 

turns off relative to ignition. This feature is useful for service and delivery fleets. 

• Driver ID relay manages when the relay turns on and off when both an IOX-NFC and IOX-RELAY are 

connected to the GO device. The Turn Driver ID Relay on and off options are used to manually turn the 

relay on or off from AT&T Fleet Management for Enterprise/Government. Use driver key to control 

Driver ID relay opens the relay when a viable NFC fob is swiped. 

• Automatic vehicle management marks vehicles as historical when the GO device is unplugged and 

adds new vehicles when a GO device is plugged in. This feature assists with vehicle organization. 

• Fuel tank capacity is a reasonable estimate of a vehicle’s fuel tank capacity. Useful for reporting on 

fuel economy. 

• Auxiliaries tab is used if a device is connected to one or more IOX-AUX cables, and contains options 

specific to the AUX. Invert: toggles AUX inputs to invert (AT&T Fleet Management for 

Enterprise/Government will state true when AUX is false). This is sometimes required to correct AUX 

behavior. Beep On: toggles AUX inputs that cause the device to beep when AUX is true and the vehicle 

is over the speed chosen. 

• Custom Parameters tab is used only when necessary. Your support team can add custom parameters if 

required. 
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Status Groups 

Drivers with Garmin-equipped vehicles can update their working status by choosing from a set of common 
statuses. 

 

1. Click on Rules & Groups in the menu to the left of the database then click on Groups. 

2. Select the plus symbol to create a new group. 

3. Click in the field to the right of “Name” and enter “Status Groups”. 

4. Click on the Save button at the top of the page. 

5. Repeat the process by creating up to four subgroups inside of “Status Groups”. Each group should be 

the name of a status the driver can select. 

 

 
6. Click on Vehicles in the menu on the left side of the database. 

7. Click on the desired vehicle. 

8. Select the Groups tab. 

9. Click the dropdown arrow to the right of “Messaging status groups” and click on the desired group or 

click in the field labeled “Select group” and enter the name of the status group. 

10. Click on the Save button at the top of the page when complete. 

 
Top  
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Mass Editing Vehicles 

Mass editing is used to make changes to the device settings, driver feedback, and group assignments for 
multiple vehicles at the same time.  

1. Click on Vehicles menu to the left side of the homepage.

2. Click on the checkmark dropdown in the upper right of the vehicle list.

3. Click on “visible”, “individual”, or “all in filter”.

Note: If selecting individual vehicles, click the check mark to the right of the desired vehicle(s).

4. Click on the Edit selected devices button at the top of the page.

5. Make the desired edits.

6. Click on the Save button at the top of the page when complete.

Top 

Watchdog Report 

The Watchdog Report shows if devices are communicating, offline, or have not yet been installed in a 
vehicle. It is designed to provide a quick snapshot to help manage uptime and productivity within a fleet. 

1. Click on Vehicles in the menu to the left of the database.

2. Click on the View dropdown and then click on Watchdog Report.

3. The vehicle displays.

4. Click either the PDF or Excel icons to download the report.

Top 
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Activity 

Risk Management 

The Risk Management report displays information on driving time, idling time, speed, length of stops, and 
up to six exception rules. Because it uses so much data, the report is often used as a template to create 
various custom reports related to productivity, efficiency, and safety. 

 

1. Click on Activity in the menu to the left of the database and then click on Risk Management. 

2. The “Options” Menu populates. Click on the desired time frame under “DATE PERIOD”. 

Note: You can also use the optional “SUB-PERIODS” setting.  

3. Click on up to six rules to the right of “Run report by”. 

4. Click on the Apply changes button when complete. 

 

Available Data 

Distance, idling, after hours usage, speed over 70/80/90 MPH, average speed, number of stops, 

duration, max speed, trips, exceptions data. 

 
Speed Profile 

The speed profile in AT&T Fleet Management for Enterprise/Government is a useful tool that allows users to 
quickly view a vehicle’s speed and compare it to the posted speed limits. 

 

1. Click on Activity in the menu to the left of the database and then click on Speed Profile. 

2. The “Options” menu populates. Select your desired time frame under “DATE PERIOD”. 

3. Click on the dropdown to the right of “Vehicles” and select a vehicle. 

4. If desired, select a Road speed provider, or leave set to All (recommended setting). 

5. Click on the Apply changes button. 

6. The speed profile displays with three colors including a blue line for the vehicle’s speed, a red line for 

the posted speed limit, and an orange line for the estimated speed limit. 

7. Hover the mouse over the graph for details, including the date and time. 

8. Zoom in to a specific region by scrolling the mouse wheel. 

9. Scroll left or right by clicking and dragging the mouse. 

10. Zoom back out by reversing the mouse wheel direction. 

11. Click on the View trips button to access the “Trips History” report for the selected date range. 

 
Top 
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Driver Congregation Report 

The Driver Congregation Report is used to determine when more than one vehicle or driver is in close 
proximity to others. This report can be used to monitor the productivity of your fleet and ensure there is no 
unnecessary congregating of vehicles or drivers. 

 

1. Click on Activity in the menu on the left side of the database and then click on Driver Congregation. 

2. The “Options” menu populates. Click on the desired time frame under “DATE PERIOD” and then click on 

Vehicles to the right of “View by”. 

3. Click on the dropdown to the right of “Vehicles” and select the desired vehicles.  

4. Choose parameters for congregating: “Distance from one to another”, “Minimum overlap time”, and 

“Minimum number of congregating vehicles”. 

5. Click in the field to the right of “Exclude stops in zone types” to select the zone types to exclude. 

6. Click on the Apply changes button when complete. 

 

Available Data 

Time of congregation occurred, arrival and departure times, duration, location, zone type, driver data, 

zone’s external reference. 

 

Work Hours 

Work Hours allow users to create different sets of hours and work times for their fleet. Once set up, they 
can be used to monitor after-hours usage, long lunches, late arrivals, or any other event that should or 
should not occur during a specific range of time. 

 

Editing Standard Hours 
1. Click on Activity in the menu to the left of the database.  

2. Click on Work Hours… and then click on Work Hours. 

3. Click on the “Search name” field, and type “Standard hours”. 

4. Click on Standard hours.  

5. Click the pencil icon to the right of the desired day to edit it. 

6. Make the desired changes and then click on the green check mark to save the changes, or the red X to 

cancel. 

7. Repeat steps 5 and 6 to edit the other days as desired. 

8. To add days/times click on the Add work time button. 

9. Click on the Save button at the top of the page when complete. 

Top 
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Adding New Work Hours 
1. Click on Activity in the menu to the left of the database. 

2. Click on Work Hours… and then click on Work Hours. 

3. Click on Add button at the top of the page. 

4. Click on the Add work time button. 

5. Click the dropdown field that populates and click on the desired weekday. 

6. Click in the fields to the right of the dropdown and enter a start and end time. 

7. Select the green check mark to save the changes, or the red X to cancel. 

8. Repeat steps 4 through 7 to add days/times. 

9. Click on the Save button at the top of the page when complete. 

 
Time Card Report 

The Time Card Report records accurate work hours for each vehicle and is used to assist in vehicle utilization 
and assignments. 

 

1. Click on Activity in the menu on the left of the database. 

2. Click on Work Hours… and then on Time Card Report. 

3. The “Options” menu populates. Click on the desired time frame under “DATE PERIOD”. 

4. Click on either All or Vehicle to the right of “View wok hours for”. 

5. Click on either Vehicle or Driver to the right of “View by”. 

6. To select a start from time, click in the field to the right of “Start from” and use the up or down arrow 

or enter the hour. 

7. Click on the Apply changes button when complete. 
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IFTA Reporting 

The International Fuel Tax Agreement (IFTA) exists between the 48 contiguous states of the USA and the 
Canadian provinces. Its goal is to create a uniform administration of motor fuel taxation law with respect to 
qualified interjurisdictional motor vehicles. 

 

1. Click on Activity in the menu on the left side of the database and then click on IFTA Report. 

2. The “Options” menu populates. Click on a timeframe under “DATE PERIOD”. 

3. Click on either Yes or No to the right of “Include historical data”. 

4. Click on the dropdown to the right of “Vehicles” and select the desired vehicle(s). 

Note: This report is typically run quarterly but can also be run monthly. 

5. Click on the Apply changes button when complete. 

 

 
 

Available Data 

Vehicle, state/province, enter/exit time, enter/exit odometer, mileage, fuel data (if recording fuel 

transactions) 
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Accident & Log Details 

The Accidents & Log Data Report provides a vast amount of information from the vehicle, including GPS logs, 
speed, accelerometer data, and engine data. Typically, this report is used for research as part of an 
investigation following an accident. 

 

1. Click on Activity in the menu on the left side of the database and then click on View Accidents & Log 

Data. 

2. The “Options” menu populates. Click on the desired timeframe under “DATE PERIOD”. 

3. Click on either Yes or No to the right of “Include historical data”. 

4. Click on the dropdown box to the right of “Vehicles” and select the desired vehicle(s). 

5. Click the Apply changes button when complete. 

 

 
 

Available Data 

Record value, reason, record type, vehicle, date/time, details, ignition, group, speed, lat/long, location, 

the reason for the log, engine diagnostic, controller, failure mode, engine status 
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Zones & Messages 

Zones are virtual perimeters around a geographical real-world area. They are used to identify important 
locations such as offices, customer sites, delivery locations, etc. Zones assist in establishing driver 
accountability, increasing productivity, and tracking high-value assets. 

 

1. Click on Map in the menu on the left side of the homepage.  

2. Click on the Add zone button at the top of the page.  

Note: You can also click on Zones & Messages in the menu on the left side of the homepage, then click 

Zones and click the Add button at the top of the page. 

3. Navigate to your desired location on the Map. 

4. Click on the map to set a start point for the zone. 

5. Click to place additional points. 

6. Complete the zone by click on the first point you set on the map. 

7. Enter the zone details and edit the desired options. 

8. Click on the Save button at the top of the page when complete. 

 

Available Data 

Name, zone type, group, comment, map visibility, external reference, start date, end date, create zone 

stop, latitude/longitude, color. 
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Importing Zones 

Create a spreadsheet to import zones. 

1. Click on Zones & Messages in the menu on the left side of the home screen and then click on Import 

Zones. 

2. The Import Zones page displays and includes two sample templates. 

Note: The first template uses latitude and longitude coordinates, while the second uses the street 

address.  

3. Open a blank spreadsheet, and copy and paste the sample data into it. 

4. Enter the desired Name of each zone.  

5. Enter either the Latitude and Longitude coordinates, or the complete street address with zip/postal 

code. 

6. Enter the desired information under “References” and “Comments”, or leave cells blank. 

7. Enter “Yes” or “No” under “Is the zone circular?”. 

8. Enter the zone’s diameter under “Diameter”. 

9. Save the spreadsheet as a .xlsx, .xlsm, or .zip file. 

10. Drag and drop the file into the feature provided, or click to browse for the file. 

11. The zone information displays as “Valid zones” or “Invalid zones”. 

Note: Invalid zones contain missing or invalid location information and need to be updated. 

12. Click on the import icon to the right of “Valid zones”. 
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Editing Zones 

Change a zone’s shape, edits zone attributes, or removes the zone entirely. 

1. Click on Zones & Messages in the menu on the left side of the database and then click on Zones. 

2. Click on the desired zone in the list. 

3. Edit the desired settings such as the Name, Groups, Comment, or Type. 

Note: You can also click on the show on map icon on the right side of the desired zone. Click on the 

zone in the map, and then click on Edit Zone from the menu. 

4. Click on the Save button at the top of the page when complete. 

 

 
 

 Top 
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Resizing Zones 

Resize a single zone on the Map. 

1. Click on Zones & Messages in the menu on the left of the database and then click on Zones. 

2. Click on the desired zone in the list, then click on the Show on map button at the top of the page. 

3. Select the zone on the map, then click on Change zone shape in the menu that populates 

4. Select a point on the zone and drag to resize the border. 

5. To create a new point on the zone, select the border, then drag it into position. 

6. Click on the Save button at the top of the page when complete. 

 

Removing Zones 

Deletes a single zone on the Map. 

1. Click on Zones & Messages in the menu on the left side of the database and then click on Zones.  

2. Select the desired zone from the list, and then click on the Remove button at the top of the page.  

Note: You can also click the show on map icon on the right side of the desired zone. Click on the zone 

on the map and then select Remove zone from the menu that populates. 

3. Click on the Save button at the top of the page when complete. 

 

Mass Editing Zones 

Zones in AT&T Fleet Management for Enterprise/Government can have customized settings like visibility on 
the map, group assignments, and types, and mass editing can be used to apply these settings and make 
changes to multiple zones at the same time.  

 

1. Click on Zones & Messages in the menu on the left side of the database. 

2. Click Zones and select the checkmark dropdown on the upper right of the zone list. 

3. Click on either “Select Visible” or “Select individual” in the menu. 

Note: If you click on “Select individual” you will need to click the checkboxes to the right of the desired 

zones. 

4. Click on the gear dropdown at the top of the page and then click on Edit selected Zones. 

5. Edit the desired settings. 

6. Click the Save button at the top of the page when complete. 
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Zone Types 

Zone types are used to categorize zones. The default zone types are home, office, and customer, but users 
can add and assign additional zone types. 

 

1. Click on Zones & Messages in the menu on the left side of the database and then click on Zones. 

2. Click the Types button at the top of the page. 

3. Click the Add button at the top of the page.  

4. Click in the field to the right of “Name” and enter a name for the zone type. 

5. To add a comment for the zone type, click in the field to the right of “Comment”. 

6. Click on the Save button at the top of the page when complete. 

 

Customer Visits Report 

The Customer Visits Report displays the time spent within zones for each vehicle, as well as arrival and 
departure times. This report can be used to view interactions with specific zones or all zones of a certain 
type. 

 

1. Click on Zones & Messages in the menu on the left side of the database and then click on Customer 

Visits. 

2. The vehicles list displays. Click on the desired vehicle. 

3. Click on the Options dropdown at the top of the page.  

4. Select the desired timeframe under “DATE PERIOD”. 

Note: By default, the report will display stops in all zones.  

5. Click on either Yes or No to the right of “Include historical data”. 

6. Click on either Vehicle or Driver to the right of “View by”.  

7. Click on the dropdown to the right of “Zone Types” and click on a zone type to limit the report to a 

certain zone type. 

8. Click on the Apply changes button when complete. 

 

Available Data 

Zone, vehicle, group, time of arrival, duration, time of departure, zone type, distance to arrival. 
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Creating Routes 

A route is a sequence of zones strung together to plan a path for a vehicle. Routes are valuable in tracking 
deviations from a plan and optimizing miles driven. 

 

1. Click on Zones & Messages in the menu on the left side of the database. 

2. Click on Routes… and then click on Routes. 

3. Click the Add route button at the top of the page. 

4. Click on a zone and then click on Add zone to route in the menu that populates. 

5. Repeat to add additional zones to the route. 

Note: If you do not have zones configured in the desired area you can click on “Add waypoint” and 

repeat at to draw the route from start to destination. 

6. Click on the Save route button at the top of the page. 

7. Enter a name for the route and add any comments. 

8. If desired, select the Optimize button to generate the most efficient order of stops. 

9. Click on the Save button near the top of the page when complete. 

 

Sending a Route to a Vehicle 

Send routes to vehicles.  

1. Click on Zones & Messages in the menu on the left side of the database. 

2. Click on Routes... and then on Routes. 

3. Click on the desired route from the list, then click the Send to vehicle button at the top of the page. 

4. Click on the “Select recipient(s)…” field or click the dropdown arrow to the right of it and select a 

device/group/driver. 

5. Click on the Send button at the top of the page. 

6. Click on the Save button at the top of the page when complete. 
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Creating a Route Plan 

Add a start time as well as planned stop times to the route. Useful for Actual vs. Planned reporting. 

1. Click on Zones & Messages in the menu on the left side of the database. 

2. Click on Routes... and then click on Routes. 

3. Click on the desired route from the list, and then click the Create plan button at the top of the page. 

Note: if you don’t currently have a route configured you will need to create one. 

4. Click in the field to the right of “Vehicle” and enter the vehicles name or click the dropdown arrow and 

select the desired vehicle from the list. 

5. Click in the field to the right of “Start date” and enter the desired date. 

6. Click in the fields to the right of “Zone organizer” to enter the desired distance and drive time between 

stops for each location. 

Note: The time to start from or arrive at each location populates automatically. 

7. Click on the Save button at the top of the page when complete. 
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Rules 

Default Rules 

Rules are a powerful way to monitor and manage a fleet. Designing rules around a company’s policies and 
procedures can reinforce standards and help drivers to become better at their job. Productivity, safety, and 
proactive engine monitoring are all areas that can be measured and improved with rules and conditions, 
either by standard rules or custom rules. The standard rules apply to the entire fleet, while custom rules can 
be set for certain vehicles or groups. 

 

1. Click on Rules & Groups in the menu on the left side of the database and then click on Rules. 

2. The rules display and are categorized by Safety, Productivity, and Fleet.  

3. Click the On button to the right of the desired rule to enable it. 

4. Click the question mark icon to display an explanation of each rule.  

5. Click the envelope icon to view notification recipients when the rule is broken. 
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Safety Rules 

• Harsh Braking, Hard Acceleration, Harsh Cornering monitors when g-force event thresholds are 

broken, based on the slider. Rules can be adjusted for use with passenger vehicles, pickup trucks, step 

vans, or heavy-duty vehicles. The larger the vehicle, the more sensitive the conditions should be. 

• Speeding by default is set to 6 mph/10 kph over the posted speed limit for a minimum of 20 seconds. 

Use the slider to change the speed, or enter the posted speed. 

• Seat belt rule is broken when the vehicle exceeds 6.21 mph/10 kph and driver not wearing a seat belt. 

• After Hours Usage rule is broken when a vehicle is driven outside of the designated work hours.  

• Possible Accident rule is broken when the device detects a g-force event of 2.5 in 1 second, in any 

direction. 

 

Productivity Rules 

• Idling identifies instances where the engine is running but the vehicle is not moving for longer than the 

defined period. 

• Late Arrival, Early Leave, Unauthorized Home Stops, Too Much Office Time, Long Lunch, and Long 

Stops During Work Hours are designed for work hours and zones. These rules can be used after work 

hours and after zones have been added. 

 

Fleet Rules 

• Fleet Idling is used to distinguish between idling in office versus other locations. 

• Engine Light On can be used to alert users when the check engine light illuminates. 

• Battery Drain triggers when a vehicle’s battery drops below 9 volts. 

• Unauthorized Device Removal monitors when a device is plugged back in after having been removed. 

• Engine Abuse is broken when a vehicle’s RPM level exceeds 7000. 

• Backing Up When Leaving assists in reinforcing the best practice of backing up when arriving as 

opposed to leaving. The rule is broken when a vehicle is in reverse any time between the beginning of 

the trip and the specified distance, which is 20 yards by default. 
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Custom Rules 

Custom rules are used to monitor driver behavior, engine data, vehicle utilization and more, based on your 
fleet’s needs and company policies. Like the stock rules that are built into the database already, these rules 
can be monitored in several ways, including real-time notifications and automated reporting.  
Custom rules can be applied to individual vehicles/groups, while stock rules cannot. 

 

1. Click on Rules & Groups in the menu on the left side of the database and then click on Rules. 

2. Click on the Add button at the top of the page. 

3. Click on the field to the right of “Name” and enter a name for the new rule. 

4. Click on a color to the right of “Color” to configure the color of the breadcrumb trail when the rule is 

broken.  

Note: Red is the default color. Not visible is also an option. 

5. To apply the rule to a group, click on the dropdown arrow to the right of “Publish to groups” and then 

click on the desired group. 

Note: By default, the custom rule will apply to all vehicles in the Company group. 

6. Click in the field to the right of “Comment” to add a comment. 

7. Click on the Conditions tab. 

8. Click on the desired category button or click on the More dropdown to select a category not currently 

displayed. 

9. Click on the “Add a condition…” field and enter the conditions for the rule. 

10. Fill in any required values, then select the Add button. 

11. Click on the Notifications tab. 

12. Click on the desired method of notification and enter the requested information.  

13. Click the Save button at the top of the page when completed. 

14. The new rule displays below the stock rules under Advanced. 
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Creating Custom Rules From Existing Rules 
1. Click on Rules & Groups in the menu on the left side of the database and then click on Rules. 

2. Click the pencil icon to the right of the desired rule. 

3. Click in the field to the right of “Name” and enter a name for the rule.  

4. Click on the desired color to the right of “Color”.  

5. Click on the dropdown to the right of “Publish to groups” to assign the rule to a specific group. 

6. Click in the field to the right of “Comment” to enter a comment. 

7. Click on the Conditions tab. 

8. Click on the condition(s) you would like to add, or click the Advanced conditions editor icon to change 

conditions in the code. 

Note: If using the Advanced conditions editor, click in the field under “ADVANCED CONDITIONS 

EDITOR” to make your edits. 

9. Click on the Notifications tab and select the desired notifications method. 

10. Enter the requested notification information. 

11. Click on the Save button at the top of the page when complete. 

 

Available Conditions 
• Add Engine includes Active Fault measured as on or off (active faults only), Any Fault measured as on 

or off (active and inactive faults), and Measurement or Data which is the reported value, as opposed to 

on or off. 

• Add Zone or Zone Type includes Entering zone, Exiting zone, Outside zone, Inside zone, and Stopped 

inside zone. Zone These can be based on an individual zone, or all zones of a specific type (customer, 

home, office). 

• Add Speed sets a threshold for over or under the defined speed. 

• Add Speed Limit defines speed allowed over the posted limit. Includes or excludes estimated speed 

limits, and specifies the road speed provider (Commercial, Community, All). 

• More includes conditions for Device, Trip, Auxiliaries,  

o Device — Device Ignition specifies ignition on or off, Device creates a rule for a specific device, 

and Driver creates a rule for a specific driver. 

o Trip — Trip Driving means the vehicle must be driving to meet conditions, Stop means the 

vehicle must be stopped to meet conditions, Trip Distance means the trip distance must be 

above, below, or equal to the value, and the Trip Duration must be above, below, or equal to 

value.  

o Auxiliaries — Monitor on/off sensors, external input devices connected to the GO device. 

o Work Hours — After work hours rule means the event must occur after a given set of work 

hours, Work hours rule means the event must occur during a given set of work hours, After 

work hours device means the event must occur after a vehicle’s assigned work hours, and 

Device work hours means the event must occur during a vehicle’s assigned work hours. 
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o Wrappers — Is value more than/less than/equal to is used for conditions that do not already 

require these values, and Invert result inverts all conditions. 

o Logic — And means already assumed when using multiple conditions, and Or means must be 

selected manually. 

 

Exceptions Reporting 

Exceptions occur when a rule is broken. After setting up rules and gathering data, exceptions reporting can 
provide valuable insights into driver behavior. 

 

1. Click on Rules & Groups in the menu on the left side of the database and then click on Exceptions.  

2. The “Options” menu populates. 

3. Click on the desired time frame under “DATE PERIOD”.  

4. Click on either Vehicle or Driver to the right of “View by”. 

5. Click on the dropdown to the right of “Vehicles” and select the desired vehicle(s).  

6. Click on the dropdown to the right of “Rules” and select the desired rule from the menu. 

7. Click on the Apply changes button. 

8. A list of exceptions displays.  

9. Click on the desired vehicle or driver for more details. 

Note: if multiple rules are selected you will need to click on the exception name before you select a 

vehicle or driver. 

 

Available Data 

Vehicle, driver, group, rule, duration, distance, count, location, details, date/time 
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Notifications 

Real-time notifications allow users to stay up to date on critical information and decrease their reaction time 
to important events. With optimal usage, they can increase the efficiency of fleet managers and 
maintenance personnel, and aid in making informed business decisions. 

 

Setting Up Email Notifications 
1. Click on Rules & Groups in the menu on the left side of the database and then click on Rules. 

2. Click the pencil icon to the right of the desired rule, and then click on the Notifications tab. 

3. Click on the Add email button. 

4. Click on the dropdown to the right of “TEMPLATE” to select the desired template. 

5. Click in the field to the right of “EMAIL” and enter the recipient’s email address. 

6. Click the Add button. 

7. Repeat steps 3 through 5 for additional recipients. 

8. Click the Save button at the top of the page when complete. 
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Notification Templates 
Send notifications using three types of templates. 

1. Click on Rules & Groups in the menu on the left side of the database and then click on Rules. 

2. Click the Notification templates button, and click on the desired template type button at the top of the 

page. 

• Add email template is a notification with field tokens. 

• Add web template is a notification posted to a web URL with field tokens. 

• Add text template is a popup notification with field tokens.  

3. Enter the requested information.  

4. Click on the desired tokens in the list under “AVAILABLE TOKENS”.  

Note: Do not change the token’s name or remove parentheses. 

5. Click on the Save button at the top of the page when complete. 

 

 
 

 Top 
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Distribution Lists 
Create a list of users that receive notifications when a rule is broken.  

1. Click on Rules & Groups in the menu on the left side of the database and then click on Rules.  

2. Click on the Distribution lists button at the top of the page. 

3. Click the Add button at the top of the page. 

4. Click in the field to the right of “Name” and enter a name for the list. 

5. Click on the Add email button. 

6. Click on the dropdown to the right of “TEMPLATE” and select the desired email template. 

7. Click in the field to the right of “EMAIL” and enter the desired email address(s). 

8. Click on the Add button. 

9. Click the Save button at the top of the page when complete. 

 
Viewing Previous Vehicle Locations 

Occasionally, there is a need to find out if any drivers were in a specific area at a certain time. This data can 
be pulled by first creating a zone, then creating and applying a custom rule to view zone interactions. 

 

1. Click on Rules & Groups in the menu on the left side of the database and then click on Rules. 

2. Click the Add button at the top of the page. 

3. Enter the desired rule attributes. 

4. Click on the Conditions tab and then on the Add zone or zone type button. 

5. Click on either Zone or Zone Type to the right of “Type”. 

6. Click on the field to the right of “Zone” and select the desired zone from the list. 

7. Click on the desired option to the right of “Event”. 

8. Click on the Add button. 

9. Click the Save button at the top of the page when complete.  

Note: Data is generated for events from this point forward.  
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Reprocessing Data 

Generate exceptions for vehicle activity that occurred in the past. Thirteen months is the maximum period that 

data can be reprocessed. 

1. Click on Rules & Groups in the menu on the left side of the database and then click on Rules. 

2. Click the Reprocess data dropdown at the top of the page. 

3. Click on the field to the right of “Start date” and use the calendar that populates to select the desired 

start date. 

4. Click on the dropdown to the right of “Vehicles” and select the desired vehicle(s). 

5. Click the Apply changes button when complete. 

 

 

Groups 

Groups are designed to separate data into sections for ease of viewing and reporting. Vehicles, users, rules, 
and zones use groups to organize a fleet. Groups are also used to designate data access. Assets assigned to a 
group will be visible to any users that have access to that group or higher (one of its parents). 

 

Popular Grouping Options 

• Locations 

• Vehicle Types 

• Industry 

• Department 

• Ownership type (leased/owned/rental vehicles) 
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Creating Groups 

Create groups to organize vehicles, users, and zones. 

1. Click on Rules & Groups in the menu on the left side of the database and then click on Groups. 

2. Select the plus symbol to create a new group or subgroup. 

3. Click in the field to the right of “Name” and enter a name for the group. 

4. Click in the field to the right of “Description” to enter a description for the group. 

5. Click on the desired color to the right of “Color”. 

6. Click on the Save button at the top of the page when complete. 

 

 
  

Editing Groups 

1. Click on Rules & Groups in the menu on the left side of the database and then click on Groups. 

2. Click on the group or subgroup you would like to edit. 

3. Click on the Edit button at the top of the page. 

4. Edit the desired settings or attributes. 

5. Click on the Save button near the top of the page when complete. 

 

Moving Groups 

1. Click on Rules & Groups in the menu on the left side of the database and then click on Groups. 
2. Click on the group or subgroup you would like to move. 

3. Click the Move button at the top of the page. 

4. Click on the new destination parent group. 

5. Click on the Move to Selected button at the top of the page. 
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Removing Groups 

1. Click on Rules & Groups in the menu on the left side of the database and then click on Groups. 
2. Click on the group or subgroup to remove. 

3. Click on the Remove button at the top of the page. 

4. A confirmation message populates, click on Remove.  

Note: Groups cannot be removed while subgroups are attached, or if assets or users are still assigned. 

 

Groups Filter 

After groups have been created and assigned to vehicles, users can choose to view only certain groups of 
assets at a time. This is accomplished with the groups filter box located in the upper left corner of the screen 
and is helpful for isolating groups for vehicle tracking, zone interactions, or exceptions reporting. 

 

1. Click in the field labeled “Groups Filter” at the top left of the database and start typing the desired 

group’s name, or, click the dropdown arrow to the right to select a group. 

Note: The application only displays information for the groups selected. The application only displays 

groups and subgroups the user is assigned to. 

2. To remove the group, filter click the X sign to the right of the group name. 
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Engine & Maintenance 

Engine Faults  

The GO device monitors the health of the vehicle by recording both the dash warning lights and the faults 
recorded by the vehicle. Additionally, the GO device is self-reporting, allowing users to view telematics 
related faults. 

 

1. Click on Engine & Maintenance in the menu on the left side of the database. 

2. Click on Engine and Device and then click on Faults. 

3. The options menu populates, click the desired time frame under “DATE PERIOD”.  

4. Click on either Yes or No to the right of “Include historical data”.  

5. Click on the dropdown to the right of “Vehicles” to select a vehicle. 

6. Click on the dropdown to the right of “Diagnostics” to focus on a specific diagnostic. 

7. Click on either Yes or No to the right of “Show dismissed faults”.  

8. Click on the Apply changes button to complete. 

 

 

Fault Types 

• OBD are engine faults recorded by the Engine Control Module (ECM). Some faults can result in check “

engine light”. Description is the description of the fault code. 

• Telematics device is used for notes or issues with the device itself (i.e. accelerometer calibrations, 

power removal, firmware updates, etc.). Can indicate possible installation issues or other important 

alerts. 

 

Available Data 

Vehicle, group, fault, count, date/time, description, source, controller, code, failure mode. 
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Engine Measurements 

Engine measurements provide a log of all engine data received by the GO device. View available 
measurements and ranges, identify measurements available for specific vehicles and determine 
measurements to be used for rules, maintenance.  

 

1. Click on Engine & Maintenance in the menu on the left side of the database. 

2. Click on Engine and Device… and then click on Measurements. 

3. The Options menu displays. Select the desired time from under “DATE PERIOD”. 

4. Click on either Yes or No to the right of “Include historical data”. 

5. Click on the dropdown to the right of “Vehicles” and select the desired vehicle(s).  

6. Click on the dropdown to the right of “Diagnostics” and select the desired diagnostic(s). 

Note: If no diagnostic is selected, the report returns all measurements for the date range. 

7. Click on the Apply changes button. 

8. Click on a measurement name to view individual events, or the graph to view the data in a visual 

format. 

 

 
 

Available Data 

Vehicle, group, measurement, range, graph, date/time, description, source, controller, value 
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Fuel Usage 

Display fuel consumed, distance driven, and fuel economy for the period selected. 

1. Click on Engine & Maintenance in the menu to the left of the database and then click on Fuel Usage. 

2. The “Options” menu populates, click on the desired timeframe under “DATE PERIOD”. 

Note: You can also click on the On button to the right of “SUB-PERIODS” to include a sub-time period. 

3. Click on Yes or No to the right of “Include historical data”. 

4. Click on the dropdown to the right of “Vehicles” and select the desired vehicle(s). 

5. Click on the Apply changes button when complete. 

6. Click on the Fill-Ups button at the top of the page to view fuel transactions. 

 

Maintenance Reminders 

Proactive maintenance is critical in keeping a fleet running smoothly. Remembering when to perform oil 
changes, tire rotations, and other automotive services can be completely automated using accurate GPS 
fleet tracking. Create recurring reminders to alert you when a vehicle is due for service. 

 

1. Click on Engine & Maintenance in the menu on the left side of the database. 

2. Click on Reminders and then click on Reminder Rules. 

3. Click on the Add button at the top of the page. 

4. Click in the field to the right of “Description” and enter a descriptive name for the rule. 

5. Click on the dropdown to the right of “Reminder rule type” and select the desired rule.  

Note: You can also click on the Add new type button to create a new rule type. 

6. Click on either “No”, “Reoccurs every”, or “Once-off” to the right of “Create reminder based on time” 

to make the reminder usage threshold for the maintenance event. 

7. Click on the desired options. 

Note: The options displayed differ depending on the setting chosen in step 6. 

8. Click on the Vehicles tab. 

9. Click in the field labeled “Search vehicles” and enter the desired vehicle’s information, or click on the 

dropdown to the right of the field to select the vehicle from a list. 

10. Repeat step 9 to add more vehicles. 

11. The vehicles information displays. Including the current date, odometer reading, and engine hours.  

12. Click in the fields under “Date”, “Odometer”, or “Engine hours” to log the most recent maintenance. 

13. Click the Save button at the top of the page when complete. 
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Reminders Due 

1. Click on Engine & Maintenance in the menu on the left side of the database. 

2. Click on Reminders and then click on Reminders Due. 

3. The “Options” menu populates. Click on the dropdown to the right of “Reminder rule” and select the 

desired rule. 

4. Click on the dropdown to the right of “Vehicles” and select the desired vehicle(s). 

5. Click on either ‘Upcoming”, “Overdue”, or “Advanced” to the right of “Due period” to select the desired 

due period.  

6. Click on the Apply changes button when complete. 

7. Select the plus symbol to the right of the desired reminder to log maintenance. 

8. Click in the field to the right of “Date completed” and enter the date that the maintenance took place.  

9. Click in the field to the right of “Vehicle odometer” to update the mileage.  

10. Click in the field to the right of “Engine hours” to update the vehicle’s engine hours. 

11. Click in the field to the right of “Comments” to enter a comment. 

12. Click the Save button at the top of the page when complete. 

 

Maintenance History 

1. Click on Engine & Maintenance in the menu on the right side of the database. 

2. Click on Reminders and then click on Maintenance History. 

3. Click on the Options dropdown.  

4. Click on the desired time frame under “DATE PERIOD”. 

5. Click on the dropdown to the right of “Reminder rule” and select the desired rule. 

6. Click on either Yes or No to the right of “Show completed maintenance”. 

7. Click on either Yes or No to the right of “Show historical vehicles”. 

8. Click on the dropdown to the right of “Vehicles” and select the desired vehicle(s). 

9. Click on the Apply changes button at the top of the page when complete. 
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Administration 

Audit Log 

The Audit Log lists events that have occurred in the database. This report is useful for tracking changes to 
your account when multiple users have administrative access. 

 

1. Click on Administration in the menu on the left side of the database. 

2. Click on System and then click on Audit Log. 

3. Click on the Options dropdown. 

4. Click on the desired time frame under “DATE RANGE”.  

5. Click in the field to the right of “Audit types” and click on the desired audit type. 

6. Click on the dropdown to the right of “Users” and select the desired user(s). 

7. Click on the Apply changes button when complete. 

 

Available Data 

User, event, details, date/time 

  

User Options 

Display user preferences such as regional, Map and UI settings; and applicable HOS rulesets. 

1. Click on your username in the upper right corner of the database and then click on Options. 

2. Edit the desired settings. 

Note: The “Main Settings” tab contains regional and UI settings. The “Map Settings” tab contains map 

settings. The “HOS Settings” tab contains rulesets and other HOS settings. 

3. Click on the Save button at the top of the page when complete. 
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Viewing Users 

Display a navigable list of users and their details.  

1. Click on Administration in the menu on the left side of the database and then click on Users. 

2. Click on the desired user to view or edit details. 

 

 
 

Available Data 

User name, first/last name, groups, last access date, security clearance, data access, active from/to, 

employee number, driver ID. 
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Adding Users 

1. Click on Administration in the menu on the left side of the database and then click on Users. 

2. Click the Add button at the top of the page. 

3. Click in the field to the right of “User (Email)” and enter the user’s email address.  

4. Click in the field to the right of “First name” and enter the users first name. 

5. Click in the field to the right of “Last name” and enter the users last name.  

6. Click on the dropdown to the right of “Authorization type” and click on the desired type. 

7. Click on either Yes or No to the right of “Force password change on next login” 

Note: If you click on No you will be required to enter and confirm a password for the user. 

8. Click on the dropdown to the right of “Security clearance” and select the desired clearance. 

Note: By default, users can see information for all vehicles. To limit them to a specific group, select the 

group from the Data access dropdown list. 

9. If desired, add in the user’s designation, employee number, or any comments. 

10. If the user is a driver, click on the Driver tab. 

11. Click on the Yes button to the right of “This user is a driver” and then enter the information requested. 

12. Click on the UI Settings tab to configure the regional settings and UI settings. 

13. Click on the Map Settings tab to configure the default map type, view, and zone display. 

14. If the user is a HOS driver, click on the HOS Settings tab and select the desired options for your user. 

15. Click on the Save button at the top of the screen when complete. 

16. After creating the user, the system will send an email prompting them to create their own password. 

To create a password for the user, set Force password change on next login to No. 

 

Security Clearances 

Security clearances allow administrators to control exactly what other users are allowed to see and do in the 
database. 

 

There are six default security clearances, ranked below from most permissions to fewest: 

• Administrator provides Access to all data and features. 

• Supervisor cannot administer groups, security clearances, or users; cannot change global system 

settings. 

• View only can view all data but cannot make any changes. 

• Default user is used primarily for vehicle tracking. 

• Drive App user is used for HOS drivers using Geotab Drive. 

• Nothing is access to Getting Started & Help only. 
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Creating Custom Security Clearances 

1. Click on Administration in the menu on the left side of the database and then click on Users. 

2. Click on the Clearances button at the top of the page. 

3. Click on the clearance on which to base the custom clearance. 

4. Click on the Add Sub-clearance button at the top of the page. 

5. Click in the field to the right of “Name” and enter a name for the sub-clearance. 

6. Click on the X or Checkmark icon to the left of the desired permission to enable or disable it. 

Note: an X designates that the permission is disabled, a checkmark designates that it is permitted.  

7. Click on the Save button at the top of the page when complete.  

8. The new clearance displays in the security clearance dropdown list when adding or editing a user. 

 

Mass Editing User Options 

Edit information, driver settings, and regional and UI settings for multiple users at the same time.  

1. Click on Administration in the menu on the left side of the database and then click on Users. 

2. Click the check mark icon in the upper right of the Users list. 

3. Click on either “Select visible”, “Select individual”, “Select all in filter”. 

Note: You will need to click the checkmark to the right of the desired users if you click on “Select 

individual”. 

4. Click the Edit selected users button at the top of the page. 

5. Make the desired edits. 

6. Click on the Save button at the top of the page when complete. 
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